12 June 2018

Requesting Travel Advances in TPAX

Introduction The following guides provide the information for requesting travel

advances in TPAX.
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12 June 2018

Requesting a PCS Travel Advance via Proxy

Introduction This guide will help you request a PCS Travel Advance (as a Proxy).
Procedural Prior to initiating the request, scan all relevant/supporting paperwork
Warning (orders, PCS worksheet, etc.) to a place where you can easily locate it.
Procedures See below

Step Action

1 Log into TPAX as you normally do:

Web TPAX Login

Last Buld: Sapiamber 7, 2018 (6.21.5)

Continued on next page
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Requesting a PCS Travel Advance via Proxy via Proxy,

Continued
Procedures,
continued
Step Action
2 Change your View to Proxy.
coasme, Joov T-PAX Inbox view: LT
[Reservations] [Regulations] [Currency]
3 Under Create New select Advance Request.
ok T-PAX Inbox View:
[Reservations] [Regulations] [Currency]

Profile and History » | Create New » Tools » Help»
Authorization Request

Created | Autn
‘catego'y‘ By | oOfficial

Status

Status

Arrive
At

Request

D ‘Amoum

QOrigin

Date

S
ssN ettlement Request
Advance Request

Continued on next page
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Requesting a PCS Travel Advance via Proxy via Proxy,
Continued

Procedures,
continued

Step Action

4 Enter the member’s Emp. ID, click Search and then OK.

Select Traveler

Emp. ID: SEN: Last Name:
555546 |COASTIE, TREVOR | Search |

I o

Address-1. (444 SE QUINCY STREET |

Address-2: | | Grade/Rank: |ET |

City: |TOPEKA Organization: |?g4?4{]ﬂ |

|
State/Country: |KANS-|!\S | DSSM: | |
|

Zip Code: |35533

I OK Cancel Help

Continued on next page
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Requesting a PCS Travel Advance via Proxy via Proxy,
Continued

Procedures,
continued
Step Action
5 Enter the TONO and click OK.
ELALDULE 2 Travel Order Selection hES
Settlement
TONO: |121TGS?[}DDDDUUDD |
Order Number Category | StartDate | End Date m('):b'f‘md Date OBl.
. Select an existing order or enter a new order B - | —
number with which you wish to work and then ance =

click the OK button

Continued on next page
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Requesting a PCS Travel Advance via Proxy, Continued

Procedures,
continued
Step Action
6 Enter the member’s Grade/Rate and change Type of Order to PCS. Pick

appropriate choice from Type of PCS drop-down. Click the Origin hyperlink and
enter the old duty station. Click the Destination hyperlink and enter the new duty

station. See successive (next two) screen shots.

View: Proxy
COASTIE, TREVOR Travel Order =os
* Grade/Rank: " Order Mumber(s): " Type of Order.
PCS v
| E7 v|  [1217G87000000000 L l
Description What's Authorized Dependents Remarks
* Type of PCS | Station to Station |
* Issue Date D1M7/2017 B
Trip Mame: | |
* Detach Date 02/01/2017 [
Issuing Crganization |?5\474GE| |
*
Paying Organization [7e47400 | Report Date 0211712017 B
Group Travel |:|
Funds [Coast Guard v
* Origin Click to enter Location from which travel will com
* Destination Click to enter new Permanent Dufy Station Location
‘ ‘ Cancel | ‘ E2s ‘

Continued on next page
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Requesting a PCS Travel Advance via Proxy, Continued

Procedures,
continued

Step Action

7 Enter the Location of the Old Duty Station. Click Accept.

Origin - Location of Old Duty Station

Country / State]  ccows cos Zp Code | City:
[KS KaNSAS | [Topeka, Shawnee

[Ks KANSAS v [ Topeka, Shawnee v

County / Locality:
[TOPEKA / SHAWNEE |

[ |

Accept Cancel

8 Enter the Location of the New Duty Permanent Station. Click Accept.

Destination - Location of New Duty Station

Country / State.  ccows cons Zip Code f City:
[MA MASSACHUSETTS | [Boston, Suffolk |
[ MA MASSACHUSETTS v| [ Boston_ Suffolk v
County / Locality:
[BosTONM 7 SUFFOLK |
| v]

Accept Cancel

Continued on next page
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Requesting a PCS Travel Advance via Proxy, Continued

Procedures,
continued
Step Action
9 You should be navigated back to the Travel Order page. The page should reflect

the Origin and Destination of your Traveler. Ensure Issue/Detach/Report dates
are correct or adjust as necessary. Click the What’s Authorized tab.

COASTIE, TREVOR Travel Order R
* Grade/Rank: ’ Order Mumber(s):  Type of Order:
FCS
E7 v 1217G87000000000 ~

Description What's Authorized Dependents Remarks

* Type of PCS [Station to Station M
* lssue Date 011712017 B
Trip Mame: | |
* Detach Date 0200172017 B
Issuing Crrganization |?5\474GE| |
¥
Paying Organization [7e47400 | Report Date 02/17/2017 B
Group Travel O
Funds [Coast Guard ~
* Origin I opeka, K5, Shawnee
* Destination Taton. TiA i

e ] o ] [ ]

Continued on next page
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Requesting a PCS Travel Advance via Proxy, Continued

Procedures,
continued
Step Action
10 | Select relevent items and click Dependents tab.
COASTIE, TREVOR Travel Order View: Proxy
* Grade/Rank: " Order Mumber(s): * Typs of Order:
E7 hd 1217G87000000000 ECS| Al
Description What's Authorized Remarks
[ ship POV TLE ] Emergency TLE
bLa I‘Mth Dependents VI D Procesd Time D Separate COT Travel
Household Goods Mone ~
‘ Back ‘ ‘ Next ‘ ‘ Save ‘ ‘ Cancel ‘ ‘ Help ‘

11 | If the member has a previous PCS move, you need only click Get Dependents
and a list of dependents will appear.

View: Proxy
COASTIE, TREVOR Travel Order
* Grade/Rank: " Order Mumber(s): Type of Order.
=
ET ~ 1217G87000000000 2GS =
Descripti What's Remarks
Name of D i o oy Birth / Marriage Date | | |
|| Get Dependents I | Add ‘
Back | | Next ‘ Save | ‘ Cancel | ‘ Help

Continued on next page
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Requesting a PCS Travel Advance via Proxy, Continued

Procedures,
continued
Step Action
12 | You may have to add dependents. If so, click Add to enter dependents.
COASTIE, TREVOR Travel Order View: Proxy
* Grade/Rank: * Order Mumber(s): * Typs of Order:
E7 v 1217G37000000000 Fes s
Description What's Authorized Dependents Remarks
Name of D Relationship to Birth / Marriage Date | | |

| Get Dependents | | Add |

‘ Back ‘ ‘ Next ‘ ‘ Save ‘ ‘ Cancel ‘ ‘ Help ‘

13

To enter dependents: Type the name, choose the relationship from the drop-
down, enter the relevent date and click Accept. Repeat as necessary.

COASTIE, TREVOR Travel Order View: Proxy
* Grade/Rank: * Order Number(s): * Type of Order.
PCS ~
ET ~ 1217G87000000000
Descripti VWhat's i Remarks
MName of Dependent = [zin Date
Member!
Daniells P. Coastie || [Spouse ~ 1 [ 08/04/2014 AccepfCancel | Delste
Get Dependents

Continued on next page
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Requesting a PCS Travel Advance via Proxy, Continued

Procedures,
continued
Step Action
14 | Navigate to Remarks and enter relevent information. Click Save.
COASTIE, TREVOR Travel Order View: Proxy
* Grade/Rank: " Order Mumber(s): * Typs of Order:
ET L 1217G27000000000 =5 e

Description Vwhat's Authorized Dependents

Order Remarks:

YOU MAY USE REMARKS FOR ANY INFORMATION DEEMED
NECESSARY TO THE PCS

[ e ][]

15 | This will bring up the Advance Request screen. Click Entitlements.

COASTIE, TREVOR Wiew: Proxy
TONO: 1217G87000000000 Advance RequeSt

Type of order: PCS ] Cowvered from: | 2/1/2017 | to: [ 272017 |

Type of Advance Full Advance | Type of Partial: |Not a Partial ~

Remit To I Entitlements I Computations Financial Remarks

* Address 1: [444 SE QUINCY STREET |

Address 2- | ]
T City: | TOPERA |
*Country/State: [KS KANSAS ~]

Zip:

| MNext | | Manage Images SAVE || Cancel || Help

Continued on next page
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Requesting a PCS Travel Advance via Proxy, Continued

Procedures,
continued

Step Action

16 | Check Claim is Precomputed.

Type of order: | PCS | Covered from: [ 212017 | to: 2172017 |
Type of Advance  Full Advance ~| Type of Partial: |Nota Partisl v
Remit To Entitlements Computations Financial Remarks

| Claim is Precomputed M| i Tl Kl A| From Date[ 2zm7 |
Member/Employee PCS Per Diem | [0.00 | ToDate  [2172017 |3

Memb/Emp Transportation

Memb/Emp Reimbursables [0.00 |

Marbiep RegstatonFos

Memb/Emp MALT 0.00 I

Dep. Per Diem W
< >
| oo [ et | [ oo oces [ s ][ ot ][ v |

Continued on next page
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Requesting a PCS Travel Advance via Proxy, Continued

Procedures,
continued
Step Action
17 | Enter the appropriate Amounts from the orders (either 80% of total entitlement or
a reduced amount requested by the member). Please ensure you are entering the
amounts in the correct type (TDY vs.PCS). Click Next.
COASTIE, TREVOR View: Proxy
T ONO: 424 7C87000000000 Advance Request
Type of order: | PCS | Covered from: 202017 | to: 2172017
Type of Advance Full Advance | Type of Partial: | Not a Partial W
Remit To Entitlements Computations Financial Remarks
. - Type Amount __I
Claim is Precomputed M1 e TP Dherm oo | ~| From Date
Member/Employee PCS Per Diem W ToDate a8
Memb/Emp Transpertation 750.00
Memb/Emp Reimbursables 0.00
Memb/Emp Registration Fees 0.00 |
Memb/Emp MALT [750.00
Dep. Per Diem [0.00 | ™
< ' >
Back ‘ Next | Manage Images ‘ SAVE H Cancel ” Help ‘

13

Continued on next page
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Requesting a PCS Travel Advance via Proxy, Continued

Procedures,
continued
Step Action
18 | This will bring up the Computations tab with the appropriate amounts as

previously entered. Verify Totals are correct and click Next.

COASTIE, TREVOR View: Proxy
TONO: 1217GE7000000000 Advance Reques.t
Type of order: | PCS | Coveredfrom: [ 212017 | +to: [ 21172017 |
Type of Advance | Full Advance | Type of Partial: Mot a Partial W
Remit To Entitlements Computations Financial Remarks

Computed Advance 3.500.00

Description Totsl
Memb/Emp PCS Per Diem 2,000.00
Memb/Emp Transportation 750.00
Memb/Emg MALT 750.00
Authorized Advance 0.00
Method of Payment | EREEIE T I - |
Due Employes
|Back|||lm”hlanapelmm ‘ SAVE ” Cancel H Help [

Continued on next page
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Requesting a PCS Travel Advance via Proxy, Continued

Procedures,
continued

Step Action

19 | You will be pathed to the Financial tab. Click Add/Modify Accounting.

COASTIE, TREVOR View: Proxy
TONO: 1217G87000000000 Advance Request

Type of order: | PCS | Coveredfrom: [ 212017 | to: [ 2172017 |
Type of Advance | Full Advance “| Type of Partial: | Nota Partial W
Remit To Entitlements Computations Financial Remarks.
DbiCr Classification String | Amount |

I Add/Modify Accounting I

| Back || Mext | ‘ Manage Images | SAVE H Cancel H Help ‘

Continued on next page
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Requesting a PCS Travel Advance via Proxy, Continued

Procedures,
continued
Step Action
20 | This will bring up a generic Line of Accounting. Do not adjust this line. Ensure
aggregate Amount is correct and click Save.
ioo:;‘ﬁ;;f‘m CG Accounting View:  Froxy
TONO Ag RID  Appr Limit Alt Al ProgEle CstAct Obj Amount
1217G37000000000 | 2| X | 000 | 000 | DD| 0 | ADV | DOOT0 | DDDDI SS.SDD.DDI Edit Del
| Save |‘ Cancel ‘ ‘ Help ‘
21 | You will be returned to the Financial page. Click Next.

COASTIE, TREVOR View: Proxy
TONO: 1217GE7000000000 Advance Req uest
Type of order: | PCS | Covered from: 201/2017 to: 211772017
Type of Advance | Full Advance “| Type of Partial: | Nota Partial W
Remit To Entitlements Computations Financial Remarks
DbiCr Classification String Amount
Db 1217GE7000000000 2 ¥ 000 00D 00 0 ADY 00000 000D 3,500.00
 AddModify Accounting |
Back ‘I Next I ‘ Manage Images ‘ SAVE ‘ ‘ Cancel ‘ ‘ Help ‘

Continued on next page
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Requesting a PCS Travel Advance via Proxy, Continued

Procedures,
continued
Step Action
22 | Enter remarks as appropriate, then click Manage Images.

COASTIE, TREVOR View: Proxy
TOMO: 1217GE7000000000 Advance Request

Type of order: | PCS | Coveredfrom: [ 22017 | to: [ 2472017 |
Type of Advance  Full Advance * Type of Partial: | Nota Partial v
Remit To Entitlements Computations Financial Rema rks --------

Voucher Remarks:
Enter amounts as appropriate

‘ Back | I Manage Images ‘ SAVE H Cancel H Help ‘

23

Click Browse, find the previously saved documents (remember the Procedural
Warning), enter Image Description and click Upload Image.

COASTIE, TREVOR _ View  Proxy
TONO: 1247G87000000000 Images and Receipts

Imeage or Receipt File Name

Browse...

Image description:

I I Upload Image

Done Help

Continued on next page
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Requesting a PCS Travel Advance, Continued

Procedures,
continued
Action
24 | Click Done once the PDF file appears.
COASTIE, TREVOR = View:  Proxy
NG 13176 Images and Receipts
Image or Receipt File Mame
Browse...
Image description:
Upload Image
Member quers
Done Help
25 | You will be returned to Remarks. Click Save.
COASTIE, TREVOR View: Proxy
TONO: 1217GE7000000000 Advance ReqUESt
Type of order: | PCS | Coveredfrom: [ 22017 | te: [ 2072017 ]
Type of Advance  Full Advance | Type of Partial: | Nota Partial v
Remit To Entitlements Computations Financial Remarks
Voucher Remarks:
Enter amounts as appropriate
‘ Back ‘ ‘ Manage Images I SAVE I| Cancel H Help |

Continued on next page
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Requesting a PCS Travel Advance via Proxy, Continued

Procedures,

continued

Release to Traveler

—

Step Action
26 | You will be pathed to your Inbox.
coksre soow T-PAX Inbox View:
[Reservations] [Regulations] [Currency]
Profile and History » Create New » Tools» Help» Logou
Type of | Start [ End Created | Auth. Status . |Armrive| Request
SSN | Name TONO ronucet| Date | Date |Category| “ae | Stk status| SRS onigin| A auest | Amount
Entered
[ |esem4s| SRS | 1217G57000000000 | Advance |2i2017 |2t70i7| ees | GRASTE _Exx 1252017 | Traveler 1100217730 53(59“23-0“
I
27 | Check the box and click Release for Approval.
COASTIE, JODY T-PAX Inbox View:
[Reservations] [Regulations] [Currency]
Profile and History » Create New » Tools» Help» Logout
Type of | Start End Created | Auth. Status . |Armve| Request
SSN | Name TONO ronuont| Date | pate |Category| “ar®? | SAT status| TR orign| AT et amount
Entered
sesass | CORSTIE | 1217687000000000 | Advance |21i2017 |2n7n017|  Pos | GOASTEE TE:X 112572017 | Traveler 100217730 53(5;3'00
I Release For Approval I | Print ‘ | View | Modify Delete

Find

19

Continued on next page
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Requesting a PCS Travel Advance via Proxy, Continued

Procedures,
continued
Step Action
28 | Select an AO, enter your Secondary Password and click OK.

COASTIE, JODY

[Reservations]

T-PAX Inbox

[Regulations]

WARNING

[Currency]

There are severe criminal and civil penalties for making or presenting a false,
fictitious, or fraudulent claim under U. S. Code Title 18, Section 237 Title 31,
Section 3729; and Title 10, Section 932 (UCMJ, Article 132)

Select an Authorizing Official

‘COAST\E. JACKE. (7847400)

[ COASTIE, JACK E._(7847400)

v

I 0K

View:

20




12 June 2018

Requesting a TDY Travel Advance

Introduction This guide provides the procedures for requesting an Advance of funds for

Temporary Duty Travel (TDY) in TPAX.

Information A Travel Authorization must be entered into TPAX before a request for an

advance can be submitted.

Procedures See below.
Step Action
1 Log into T-PAX. Click the View drop-down and select if the Advance request is

being submitted as a Traveler or Proxy.

Then click the Create New drop and select Advance Request.

fow: [Traveler v

BEAR, COASTIE T_PAX I n box View: [Traveler v
Traveler

[Reservations] [Regulations] [Currency]

Profile and History » | Create New» Tools » Help »

Authorization Request

Settlement Request Auth Status Arrive
== Categol Created B .~ | Status Origin
Advance Request gory Y | official Date 9 At
66663
1117333CCC000000 | Authorization | 4/1/2017 |4/30/2017| Normal BEAR, | COASTIE, | Approved| 5150017 | Traveler | Topeka,
COASTIET. | JOANN'| byAo
: KS

< >

The Travel Order Selection page will display. Click on the TONO link for the
applicable orders.

BEAR, COASTIE Travel order Selection View: Traveler
Settlement
TONO: |
1117333CCC000000 |pel|  Normal | 472017 4/30/2017

Select an existing order or enter a new order
number with which you wish to work and then
click the OK button

OK Cancel Help

Continued on next page
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Requesting a Requesting a TDY Travel Advance, Continued

Procedures,
continued
Step Action
3 The Remit To tab of the Advance Request page will display. The top section

will display the information from the Authorization. The Type of Advance will
default to Full Advance. Verify the home address for accuracy. If incorrect,
overtype the correct information. When finished, click the Next button.

BEAR, COASTIE

Advance Request View: Traveler
TONO: 1117333CCC000000
Type of order: | Normal | Coveredfrom: [ 4/1/2017 | to: [ 4/30/2017 |
Type of Advance | Full Advance ~ Type of Partial: Not a Partial v
Remit To Entitlements Computations Financial Remarks

* Address 1: 444 SE QUINCY STREET

Address 2:

* City: |TOPEKA

*Country/State: |KS KANSAS v

Zip: 66683

I Next I | Manage Images

| SAVE || Cancel H Help |

The Entitlements tab will display. TPAX requires the Entitlements section to be
reentered when requesting an Advance. The information must be the same as
the previously entered Authorization. Click the Add This Entitlement button.

BEAR, COASTIE

Advance Request View: Traveler
TONO: 1117333CCC000000
Type of order: | Normal | Covered from: [ 4/1/2017 | to: [ 4/30/2017 ]
Type of Advance Full Advance Vv Type of Partial: |Nota Partial v
Remit To Entitlements Computations Financial Remarks
| | Entitlement Type | Dates Encompassed | Status | | |
| Temporary Duty Trip v | | <= Add This Entitlement I
Claim is Precomputed []

Continued on next page
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Requesting a TDY Travel Advance, Continued

Procedures,
continued

Step Action

5 The What’s Authorized tab will display. Click the Transportation Restrictions
drop-down and select an option. In this example the member was authorized to
travel via Privately Owned Conveyance (POC) as more Advantageous to the
Government. Click the Next button to continue.

BEAR, COASTIE Temporary Duty Trip

View: Traveler

Proceed Date: 4/1/2017

Number of Days: 30
Type of order. | Normal | End Date: |412012017

TONO: [_1117333CCC000000 |

What's Authorized Itinerary Reimbursables

Owner operator of POV

Transportation Restrictions |POC More Advantageous to the Government
POC More Advantageous to the Government
POC Limited to Cost of Constructed Travel
POC in Lieu of Gov't Veh (Avail - Not Assigned)

POC in Lieu of Gov't Veh (Avalil - Assigned to Agency)
Commercial (Rail/Air/Bus/Ship) Authorized
Government (Airehicle/Ship) Authorized

Remarks Directed Government Air

Remarks Directed Government Vehicle
Remarks Directed Travel by Air

‘ Accept Changes

6 The Itinerary tab will display. Click the Duration of travel drop-down and
choose the applicable option. Click Add / Edit Trip Itinerary.

BEAR, COASTIE Temporary Duty Trip

| Cancel H Help |

View: Traveler

| Proceed Date: |4/1/2017
Number of Days: 30
Type of order: | Normal | End Date: |4/30/2017

TONO: [ 1117333CCC000000

What's Authorized Itinerary Reimbursables

Duration of travel: |Greater than or equal to 24 hours v
[N trp merary (0 be entered |
Greater than or equal to 24 hours
. | Less than 24 hours with lodging Local?
Less than 24 hours no lodging Nethod
Less than or equal to 12 hours

AE% Lodging Taxes Miles |

Lodging | Meals

Add | Edit Trip Itinerary

| Cancel || Help ‘

| Back | ‘ Next | | Accept Changes

Continued on next page
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Requesting aRequesting a TDY Travel Advance, Continued

Procedures,

continued

Step

Action

7

Complete the first leg of the Itinerary section the same as originally recorded in
the Authorization request. Then click the Method of Reimbursement, Lodging
Type and Meals Type drop-downs and select the applicable options. When
finished, click the Accept Leg button.

BEAR, COASTIE |t| 1] erary View: Traveler
TONO: 1117333CCC000000
) 2 i ; .
Date ‘ Location R-:r:::n %:‘yy IDL | Il\i:::tl)d Lodging | Meals AE% Lodging Taxes Miles | ‘
Departure Location (click to edit) Method of Reimbursement. Daily Ldg Cost
Departure Date - =
- [63101 Saint Louis, MO, St Louis City | s Local | LDP - Lodging Plus [¥] | 01
04/01/2017 |
Method of Transportation: i T
M Duty Day [PA - Private Auto M
Lodging Type:
v IR ek o a1 |CQ - Comm'l Qirs Incidental Expense Full v |
Arrival Date [F6683 Topeka, KS, Shawnee ]
04/01/2017 _JJ Reason for Stop:
[TD - Temporary Duty v Meals Type:  M&IE: 51
[} Duty Day [CM - Commercial Meals M Miles
311
I Accept Leg I | Cancel Changes

Complete the second leg of the Itinerary. When finished, click the Accept Leg
button.

BEAR, COASTIE |t| nerary View: Traveler
TONO: 1117333CCC000000

Trans | Duty Local?

Reason | Day Method Lodging | Meals AE% Lodging Taxes Miles

Date Location

63101 Saint Louis, MO, St Louis PA )

™ | ¥ e | ca |ow |[o]eTo0 o060 ][5

4/1/2017 | DEP
4172017 | ARR

City
66683 Topeka, KS, Shawnee

Departure Location (click to edit) Method of Reimbursement Daily Ldg Cost
Departure Date
. [F5883 Topeka, K5, Shawnee ] || Chis Locar v 0
0473072017 |8

Method of Transportation
P Lodging Tax:

[ outy pay [PA - Private Auto v
Lodging Type: 0

Arrival Location (click to edit) Y
Arrival Date anm Saint Louis MO _St Louis City
04/30/2017 _JJ Reason for Stop:
|MC - Mission Complete 2 | Meals Type: M&IE: 54
CM - Commercial Meals v Miles

D Duty Day
310

I AcceptLeg I | Cancel Changes

Continued on next page
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Requesting aRequesting a TDY Travel Advance, Continued

Procedures,
continued

Step Action
9 Review the Itinerary for accuracy. If necessary, click the Edit link to make any
changes. Then click the Accept Changes button.

BEAR, COASTIE Iti nerary
TONO: 1117333CCC000000

View: Traveler

) Trans |Duty Local? ) ) .
Date Location Reason| Day IDL Method Lodging [ Meals AE% Lodging Taxes Miles

63101 Saint Louis, MO, St Louis PA v Edit Del

™ | @ e | ca | om | [O][ER0 [0 J[EA ] finser

412017 | DEP e
12017 | ARR 65653 Topeka, KS, Shawnee

4302017 | DEP 66683 Topeka, KS, Shawnee PA Edit
63101 Saint Louis, MO, St Louis Del
41302017 | ARR city MC NLG [ Insert
I Accept Changes I ‘ Cancel Changes ‘ Help

10 | The ltinerary page will display. Click the Next button to continue.

. View: Traveler
BEAR, COASTIE Temporary Duty Trip
+ 412017
TONO: [ 1117333CCC000000 | BioceediDates
Number of Days: 30
Type of order: | Normal | End Date: |4/30/2017
What's Authorized Itinerary Reimbursables
Duration of travel: [Greater than or equal to 24 hours ™|
7 Trans |D Local? q q .
Date Location Freoer Dl:: IDL Method Lodging | Meals AE% Lodging Taxes Miles
63101 Saint Louis,
4172017 DEP MISSOURI PA v
41112017 |ARR| 66683 Topeka, D) 7 LDP ca cMm [0 J[oro0 J[ o000 J[ 311 ]
KANSAS
66683 Topeka,
4/30/2017 | DEP KANSAS PA
4/30/2017 [ ARR | 63101 Saint Louis, | MC NLG [0 ][ 000 J[ o000 J[ 310 ]
MISSOURI
Add / Edit Trip Itinerary
| Back | Next | Accept Changes | Cancel H Help |

Continued on next page
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Requesting aRequesting a TDY Travel Advance, Continued

Procedures,
continued

Step Action

11 | The Reimbursables tab will display. Click the Add/Edit Trip Expenses button
to enter any reimbursable items previously entered in the Authorization. All
Reimbursable items entered will display. If no reimbursable items are to be
entered, or when finished, click the Accept Changes button.

BEAR, COASTIE View: Traveler

Temporary Duty Trip

| Proceed Date: |4/1/2017

Number of Days: 30

TONO: [___1117333CCC000000

Type of order: | Normal | End Date: |4/30/2017
What's Authorized tinerary Reimbursables
Date Description Amount
4/1/2017 TOLLS FOR ROADS-BRIDGES-TUNNELS-FERRY 100.00

Add / Edit Trip Expenses

Accept Changes | Cancel || Help |

12 The Entitlements tab will display. Click the Next button to continue.

BEAR, COASTIE Advance Req uest View: Traveler
TONO: 1117333CCC000000

Type of order: | Normal | Covered from: [ 4/1/2017 | to: [ 4/30/2017 |
Type of Advance Full Advance Vv Type of Partial: Nota Partial v
Remit To Entitlements Computations Financial Remarks
Entitlement Type Dates Encompassed Status
Edit | Temporary Duty Trip 4/1/2017-4/30/2017 Validated Data Delete | Calcs
Temporary Duty Trip v | <= Add This Entitlement |

‘ Back |I Next | Manage Images | SAVE || Cancel H Help |

Continued on next page
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Requesting aRequesting a TDY Travel Advance, Continued

Procedures,
continued
Step Action
13 | The Computations tab will display the break-down of the entitlements for the

orders. Enter the amount of the advance request in Authorized Advance. Click
Next.

BEAR, COASTIE Advance Request View: Traveler
TONO: 1117333CCC000000 q
Type of order: | Normal | Coveredfrom: [ 4/1/2017 | to: | 4/30/2017 |
Type of Advance Full Advance “ Type of Partial: Mot a Partial AV
Remit To Entitlements Computations Financial Remarks
Description Entitiement | % Advanced | Calc. Adv. Amount | Total Computed Advance
Memb/Emp MAIE Amount 1,504.50 100.00 1,504.50 1,504.50
Memb/Emp Lodging Amount 2,639.00 100.00 2,639.00 2,639.00
Memb/Emp Transportation 435.34 100.00 435.34 43534 Authorized Advance
Method of Payment | Direct Deposit v Due Employee
| Back J MNext Manage Images [ SAVE | ‘ Cancel ‘ ‘ Help ‘

14

The Accounting page will display. The information will default with the
required information and identify the Program Element (ProgEle) as an
advance. Click the Save button.

BEAR, COASTIE CG Accounting View: Traveler
TONO: 1117333CCC000000
TONO Ag R/ID  Appr Limit Allt  Alc ProgEle CstAct Obj Amount
1117333CCC000000 [ 2| x [ ooo [ oo [00| 0| aov ooooo | oooo | 5150000]  Edt Del
I Save I ‘ Cancel | | Help |

Continued on next page
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Requesting Requesting a TDY Travel Advance, Continued

Procedures,
continued
Step Action
15 | The Financial tab will display. Click the Next button to continue.
BEAR, COASTIE Advance Request View: Traveler
TONO: 1117333CCC000000
Type of order: | Normal | Coveredfrom: [ 4172017 ]| to: [__4/30/2017 |
Type of Advance Full Advance v Type of Partial: | Not a Partial v
Remit To Entitlements Computations Financial Remarks
DbiCr Classification String Amount
Db 1117333CCCO00000 2 X 000 000 00 O ADV 00000 0000 1,500 00
| Add/Modify Accounting

| Back |I Next I | Manage Images

| SAVE || Cancel || Help |

16

The Remarks tab will display. Enter any remarks concerning the Advance
request. When finished, click the Save button.

BEAR, COASTIE Advance Request View: Traveler
TONO: 1117333CCC000000

Type of order: | Normal | Coveredfrom: [ 4M/2017 | to: [ 4/30/2017 |
Type of Advance | Full Advance V| Type of Partial: Not a Partial v
Remit To Entitlements Computations Fil ial Remarks

Voucher Remarks:
Requesting ADV to cover Meals/incidentals and POV mileage.

‘ Back | |Mﬁnagelmages I SAVE I| Cancel || Help |

Continued on next page
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RequestingRequesting a TDY Travel Advance, Continued

Procedures,
continued
Step Action
17 The TPAX Inbox will display. The Advance request is ready to forward to the

unit Approving Official. Click the check box for the TONO, then click the
Release for Approval button. The Advance request Status will update to
Awaiting AO Approval. Log out of TPAX.

View:
BEAR, COASTIE T-PAX Inbox -
[Reservations] [Regulations] [Currency]
Profile and History » Create New» Tools » Help » Logout
Type of Start End Auth. Status .. | Arrive| Request
TONO Request | Date | Date Category| Created By Official Status Date Origin At D Amou A
) BEAR waingl 66683 $1.500
M 1117333CCC000000 Advance | 4/1/2017 |4/30/2017| Normal COASTIE T Apsrooval 312012017 | Traveler To;lzséka 100217761 7 gy
>
I Release for Approval I | Print | I View | Modify
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